Go Direct’

. ®
SpectroVis Plus
(Order Code GDX-SVISPL)

Go Direct SpectroVis Plus is a portable, visible to
near-IR spectrophotometer and fluorometer. This
spectrophotometer can be used in a wide range of
introductory spectroscopy experiments for chemistry, biology, and physics. Such
experiments include: determining the peak wavelength to collect data on solution
concentration for Beer’s law studies, collecting a full wavelength spectrum to
measure absorbance, percent transmittance, fluorescence, or emissions, and
monitoring rates of reaction.

Note: This sensor also works with LabQuest 2 and LabQuest 3; it does not work

Note: Vernier products are designed for educational use. Our products are not
designed nor are they recommended for any industrial, medical, or commercial
process such as life support, patient diagnosis, control of a manufacturing
process, or industrial testing of any kind.

What's Included
¢ Go Direct SpectroVis Plus
o 15 plastic cuvettes and lids
o Rechargeable battery (included inside unit; remove if data collection is strictly
via USB)
e Mini USB Cable
o Power supply (for battery recharge only; do not plug in if taking data)

Compatible Software
See www.vernier.com/manuals/gdx-svispl for a list of software compatible with

Go Direct SpectroVis Plus.

Quick Start: Vernier Spectral Analysis® and Bluetooth®

1. Charge your spectrometer for at least eight hours before first use using the
included power supply. Disconnect the power supply before attempting to
collect data. It is recommended that you not have the power supply attached
while collecting data wirelessly.

2. Turn on your sensor. The LED will blink.

Launch Spectral Analysis.

4. Click or tap Connect a Spectrometer. Select your Go Direct SpectroVis Plus
from the list of Discovered Wireless Devices. Your spectrometer's ID is
located near the barcode on the label. The Bluetooth LED on the sensor will
now glow blue (no longer flashing).

5. Click or tap DONE to enter data-collection mode. You are now ready to
continue your experiment.
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Using other Vernier data-collection apps or want to connect via
USB?

Visit www.vernier.com/start-go-direct

with the original LabQuest.

Charging the Sensor

Connect Go Direct SpectroVis Plus to the included AC power cable for at least
eight hours. Note: This is only required for data collection via Bluetooth wireless
technology.

Charging Orange LED next to battery icon is solid while
sensor is charging.

Green LED next to battery icon is solid when
sensor is fully charged.

Fully charged

Powering the Sensor

Press Power button once or connect to USB.
Green LED indicator next to Power icon is solid
when unit is on.

Turning on the sensor

Putting the sensor in sleep | Press and hold button for more than three seconds
mode to put into sleep mode. Green LED indicator turns
off when sleeping.

Connecting the Sensor
See the following link for up-to-date connection information:

www.vernier.com/start/gdx-svispl

Connecting via Bluetooth

Press Power button once. Blue LED next to
Bluetooth icon flashes when sensor is ready to con-
nect.

Ready to connect

Connected Blue LED next to Bluetooth icon is solid when
sensor is connected via Bluetooth wireless tech-
nology.
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Connecting via USB

Connected and charging Orange LED next to battery icon is solid when
sensor is connected to Spectral Analysis via USB.
LED next to Bluetooth icon is off. LED next to
power is solid green. LED next to USB icon is
solid green.

Connected, fully charged | LED next to battery icon is off when sensor is con-
nected to Spectral Analysis via USB and fully
charged. LED next to Bluetooth icon is off.

Charging via USB, con- This combination is not permitted.
nected via Bluetooth

Charging via AC power, This combination is not recommended.
connected via Bluetooth

Using the Product with Spectral Analysis
Connect the sensor following the steps in the Quick Start section of this user
manual.

Select the Type of Data to Measure
The three options for Experiment Types are:

1. Measurement vs. Wavelength—collect a full spectrum.
2. Measurement vs. Concentration—conduct a Beer's law experiment.
3. Measurement vs. Time—collect time-based data for a kinetics experiment.

By default, Absorbance is expanded. You can also choose from % Transmittance,
Fluorescence, Emissions, or Advanced Full Spectrum. Use the Advanced Full
Spectrum mode to switch between all the measurement types in the same session.
For complete instructions, refer to the Spectral Analysis user manual at
www.vernier.com/spectral-analysis

Measurement vs. Wavelength (Full Spectrum)

1. Select Measurement vs. Wavelength.

2. If applicable, follow instructions for calibration. Align the cuvette so the clear
side of the cuvette is facing the light source. Note: Calibration is not required
for fluorescence or intensity.

3. You are now ready to collect data. Fill a cuvette about 3/4 full of a sample of
the solution to be tested. Place the sample in the Spectrophotometer and click
Collect. Click Stop to end data collection. The spectrum is automatically
stored.

4. Save or export your data from the File menu.

Measurement vs. Concentration (Beer's law)

1. Select Measurement vs. Concentration.

2. If applicable, follow instructions for calibration. Align the cuvette so the clear
side of the cuvette is facing the light source. Note: Calibration is not required
for fluorescence or intensity.

3. Follow the instructions in the Choose a Wavelength dialog box. Select Done.

4. Click Collect. Your first sample should still be in the Spectrophotometer. After
the reading stabilizes, click Keep. Enter the concentration of the sample and
click or tap Keep Point.

5. Place your second sample in the cuvette slot. After the reading stabilizes, click
Keep. Enter the concentration of the sample and click or tap Keep Point.

6. Repeat the previous step for the remaining samples. When finished, click Stop
to end data collection. The data is automatically stored.

7. To see the best fit line equation for the standard solutions, click Graph Tools,
select Apply Curve Fit, and choose Linear. Click or tap Apply.

8. If doing Beer's law to determine the concentration of an unknown, place the
unknown sample in the cuvette holder. Click or tap Graph Tools and enable
Interpolate. Click or tap along the line until you find the concentration value
that matches your unknown's measurement.

9. Save or export your data from the File menu.

Measurement vs. Time (Kinetics)

1. Select Measurement vs. Time.

2. If applicable, follow instructions for calibration. Align the cuvette so the clear
side of the cuvette is facing the light source. Note: Calibration is not required
for fluorescence or intensity.

3. Follow the instructions in the Choose a Wavelength dialog box. Select Done.

4. The default data-collection settings collect measurements every two seconds
until the user manually stops data collection.

5. Mix the reactants. Transfer ~2 mL of the reaction mixture to a cuvette and
place the cuvette in the spectrometer. Click or tap Collect.

6. When finished, click or tap Stop.

7. To fit a function to the data, click Graph Tools, select Apply Curve Fit, and
choose the appropriate curve fit. Click or tap Apply.

8. To add a calculated column to the data set, click OK in the measurement
header on the data table. Select Add Calculated Column. Modify the name,
units, and displayed precision accordingly. Select Insert Expression and select
the appropriate equation. Modify the parameters and column options, if
necessary. Click or tap Apply. The calculated column is automatically
displayed on the graph.

9. Save or export your data from the File menu.

Change the Settings in Spectral Analysis
1. Click or tap the gear to show the Spectrometer Settings dialog.
2. There are three parameters listed in the dialog box:
o Integration Time: This is similar to the shutter speed of a camera.
Spectral Analysis automatically selects the proper sample time during
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calibration in Absorbance and % Transmittance modes. If using
Fluorescence, Intensity, or Advanced Experiment modes, you can modify
this value to increase the amount of light hitting the detector and the signal
spectral output.
o Wavelength Smoothing: This is the number of adjacent readings on either
side of a given value that is used to calculate an average value.
o Temporal Averaging: This is the number of readings taken at a given
wavelength to calculate an average reading.
3. Select the Calibrate button to recalibrate your spectrometer at any time.
Measure an Emission Spectrum with Spectral Analysis
You may use your Spectrophotometer to measure the emission spectrum of a light
source such as an LED or a gas discharge tube. To do so, you will need to
purchase the Vernier Optical Fiber (order code: VSP-FIBER).

Measure Intensity of Light Emissions
Insert the Vernier Optical Fiber into the SpectroVis Plus.

1. Connect the sensor following the steps in the Quick Start section of this user
manual.

2. Open Spectral Analysis.

3. Select the appropriate Emissions experiment from the listed options and follow
the prompts in the app. Intensity is a relative measure with a range of 0—1.
Note: The Spectrophotometer is not calibrated for measuring intensity.

4. Aim the tip of the optical fiber at a light source. Start data collection. Tap the
Stop button to end data collection.

If the spectrum maxes out (flat and wide peaks at a value of 1), increase the
distance between the light source and the tip of the optical fiber cable or reduce
the integration time (see the Change the Settings in Spectral Analysis section).

To adjust the integration time, click or tap the gear. Set the integration time to a
suitable value.

Measure Fluorescence with Spectral Analysis

You may use your Spectrophotometer to measure the fluorescence spectrum of an
aqueous sample, such as chlorophyll, riboflavin, and fluorescein. Fluorescence is
the emission of light by a compound after it has absorbed a particular wavelength
of light. Under most circumstances, the emission of light will occur at a longer
wavelength than the light used to excite it. The SpectroVis Plus has two excitation
wavelengths: one at 405 nm and one at 500 nm.

There are three general types of data collection that measure fluorescence—
fluorescence vs. wavelength, which produces a spectrum, fluorescence vs.
concentration, and fluorescence vs. time for kinetics experiments. To collect these
types of data after the experiment type has been selected as Fluorescence, follow
the instructions in the Spectral Analysis user manual at www.vernier.com/spectral-
analysis. Note: You may need to change the integration time to get accurate peak
intensities in fluorescence mode. To adjust the integration time click or tap on the
gear. Set the integration time to a suitable value.

Using the Product with LabQuest App
Connect the sensor following the steps in the Quick Start section of this user
manual.

Select the Type of Data (or Units) You Want to Measure
The default data type is absorbance. If you want to measure the absorbance of a

solution, proceed directly to the Calibrate the Spectrophotometer section.

If you want to measure %T, fluorescence (excited at 405 nm or 500 nm), or
intensity, do the following:

1. From the Sensors menu, choose Change Units > USB: Spectrophotometer.
2. Select the unit or data type you wish to measure.
Calibrate the Spectrophotometer (Not Required if Measuring Intensity or

Fluorescence)

1. Choose Calibrate » USB: Spectrophotometer from the Sensors menu. Note:
For best results, allow the Spectrophotometer to warm up for a minimum of
five minutes.

2. Fill a cuvette about 3/4 full with distilled water (or the solvent being used in
the experiment) to serve as the blank. After the Spectrophotometer has warmed
up, place the blank cuvette in the Spectrophotometer. Align the cuvette so a
clear side of the cuvette is facing the light source.

3. Follow the instructions in the dialog box to complete the calibration, and then
tap OK.

Collect Data with LabQuest

Measurement vs. Wavelength (Full Spectrum)

1. Fill a cuvette about 3/4 full of the solution to be tested and place it in the
Spectrophotometer.

2. Start data collection by tapping on the Start button in the lower left corner of
the screen. Tap the Stop button to end data collection.

3. Tap on the graph to select a wavelength. Note the wavelength you may want to
use for a future Beer's law or kinetics experiment.

4. To store the spectrum data, tap on the file cabinet icon in the upper right of
your screen.

Measurement vs. Concentration (Beer’s Law)

1. Generate a spectrum as described above. On the Meter screen, tap Mode.
Change the mode to Events with Entry.

2. Enter the Name (e.g., Concentration) and Units (e.g., mol/L). Select OK.

3. A message will appear warning you to either save or discard the full spectrum
run. Make your choice and proceed with data collection.

4. Set the wavelength for data collection. On the Meter screen, tap on the meter,
and select Change Wavelength. Enter the wavelength of your choice and select
OK. If the wavelength you type in is not measured by the unit, LabQuest will
automatically choose the wavelength closest to your choice.

5. Place your first Beer’s law standard solution in the Spectrophotometer. Start
data collection. After the absorbance reading stabilizes, tap Keep. Enter the
concentration of the solution and select OK.
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6. Place your second standard sample in the Spectrophotometer. After the
absorbance readings stabilize, tap Keep. Enter the concentration of the second
sample and select OK.

7. Repeat Step 5 for the remaining standard samples. After you have tested the
final standard, tap the Stop button to end data collection.

8. To calculate a best fit line equation for your standards, choose Curve Fit from
the Analyze menu. Select Linear for the Fit Equation, and then select OK. The
graph screen will appear again with the linear regression equation displayed.

9. Place a cuvette containing an unknown sample of solution in the
Spectrophotometer. Tap the Meter tab and write down the displayed
absorbance value. Tap the Graph tab and choose Interpolate from the Analyze
menu. Trace the linear regression equation to determine the concentration of
the unknown.

Measurement vs. Time (Kinetics)

1. Generate a spectrum as described above. On the Meter screen, tap Mode.
Change the data-collection mode to Time Based.

2. You can change the rate, interval, and/or duration of time of data collection, if
desired. Select OK when you are ready to proceed.

3. A message will appear warning you to either save or discard the full spectrum
run. Make your choice and proceed with data collection.

4. Set the wavelength for data collection. On the Meter screen, tap on the meter,
and select Change Wavelength. Enter the wavelength of your choice and select
OK. If the wavelength you type in is not measured by the unit, LabQuest will
automatically choose the wavelength closest to your choice.

5. Mix the reactants, transfer ~2 mL of the reaction mixture to a cuvette, and
place the cuvette in the Spectrophotometer. Start data collection. You may tap
the Stop button to end data collection early.

6. To calculate a function for your data, choose Curve Fit from the Analyze
menu. Select the Fit Equation, and then select OK. The graph screen will
appear again.

Measure an Emission Spectrum with LabQuest

You may use your Spectrophotometer to measure the emission spectrum of a light

source such as an LED or a gas discharge tube. To do so, you will need to

purchase the Vernier Optical Fiber (order code: VSP-FIBER).

Measure Intensity of Light Emissions

1. Insert the Vernier Optical Fiber into the SpectroVis Plus.

2. Use a USB cable to connect the Spectrophotometer to your LabQuest.

3. Choose New from the File menu.

4. On the Meter screen, tap Change Units » USB: Spectrophotometer »
Intensity from the Sensors menu. Intensity is a relative measure with a range
of 0—1. Note: The Spectrophotometer is not calibrated for measuring intensity.

5. Aim the tip of the optical fiber at a light source. Start data collection. Tap the
Stop button to end data collection.

If the spectrum maxes out (flat and wide peaks at a value of 1), increase the
distance between the light source and the tip of the optical fiber cable or reduce
the sample time (see the Change the Settings in LabQuest section).

To adjust the sample time, tap on Mode from the Meter screen. Set the Sample
Time to a suitable value.

Measure Fluorescence with LabQuest

You may use your Spectrophotometer to measure the fluorescence spectrum of an
aqueous sample, such as chlorophyll, riboflavin, and fluorescein. Fluorescence is
the emission of light by a compound after it has absorbed a particular wavelength
of light. Under most circumstances, the emission of light will occur at a longer
wavelength than the light used to excite it. The SpectroVis Plus has two excitation
wavelengths: one at 405 nm and one at 500 nm.

There are three general types of data collection that measure fluorescence—
fluorescence vs. wavelength, which produces a spectrum, fluorescence vs.
concentration, and fluorescence vs. time for kinetics experiments. Once the units
have been changed to Fluorescence from the Sensors menu, follow the instructions
in the Collect Data with LabQuest section of this user manual to collect these
types of data. Note: You may need to change the sample time to get accurate peak
intensities in fluorescence mode. To adjust the sample time, tap on Mode from the
Meter screen. Set the Sample Time to a suitable value.

Change the Settings in LabQuest

Data Collection Screen

The Data Collection Screen in LabQuest lists all the settings for the device. To
display this box, choose Sensors B Data Collection from the Meter screen.

For most experiments, the default settings work well.
There are four parameters listed in the dialog box.

o Sample Time: This is similar to the shutter speed of a camera. LabQuest
automatically selects the proper sample time during calibration. Note: For
emission studies, you may need to change the sample time manually.

e Wavelength Smoothing: This is the number of adjacent readings on either
side of a given value that is used to calculate an average value. Note: Be
careful adjusting this parameter as it may shift your wavelength values
slightly.

e Samples to Average: This is the number of readings taken at a given
wavelength to calculate an average reading.

o Wavelength Range: The range is determined by the type of
Spectrophotometer in use.

Videos
View videos related to this product at www.vernier.com/gdx-svispl
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Specifications
Light source Incandescent with LED support

Detector Linear CCD
380 nm—950 nm

Wavelength range
Wavelength reporting interval ~1 nm

Optical resolution (FWHM) 5.0 nm

Wavelength accuracy + 4.0 nm

Photometric accuracy +0.10 A.U.

Typical scan time ~2's

Operating temperature 15-35°C

Battery High-capacity, lithium-ion rechargeable battery

USB specification 2.0 full speed

Wireless specification Bluetooth® v4.2
Dimensions 15cm X 9 cm X 4 cm

Support for fluorescence Excitation centered at 405 and 500 nm

Safety

o When this instrument is in data-collection mode labeled Intensity, the light

source will be blocked or turned off. Continue to use proper safety precautions.

e Do not remove or modify any of the installed safety components of this
device. Doing so will create an unsafe operating condition and will void the
product warranty.

« No user-serviceable parts are in this device. Do not attempt to open or modify
this device. Contact Vernier for all repairs and service including lamp
replacement.

o Handle the device with care. This instrument can be damaged if it is dropped.

¢ Do not use this instrument if it is damaged in any way. Contact Vernier
Technical Support for troubleshooting and technical assistance.

« Do not use this instrument for clinical or diagnostic procedures.

Troubleshooting
For troubleshooting tips, see www.vernier.com/til/3847

Repair Information

o The light source in Go Direct SpectroVis Plus is an incandescent lamp. The
lifetime of this source is rated at approximately 8,000 hours.

o The lamp is covered by a three-year warranty.

o Contact Vernier for all repairs and service including lamp replacement.

o No user-serviceable parts are in this device. Do not attempt to open the case of
the device. Do not attempt to change or repair the lamp. Doing so will create
an unsafe operating condition and will void the product warranty.

If you have watched the related product video(s), followed the troubleshooting
steps, and are still having trouble with your Go Direct SpectroVis Plus, contact
Vernier Technical Support at support@vernier.com or call 888-837-6437. Support
specialists will work with you to determine if the unit needs to be sent in for
repair. At that time, a Return Merchandise Authorization (RMA) number will be
issued and instructions will be communicated on how to return the unit for repair.

Accessories/Replacements

Item Order Code
Cuvette Rack CUV-RACK
Plastic Cuvettes (Visible Range) Cuv

Vernier Spectrophotometer Optical Fiber VSP-FIBER
Replacement Battery for LabQuest® 2 and LabQuest Stream® LQ2-BAT
LabQuest Power Supply LQ-PS

Vernier Mini USB Cable
Vernier Mini USB-C Cable

CB-USB-MINI
CB-USB-C-MINI

Warranty
Warranty information for this product can be found on the Support tab at
www.vernier.com/gdx-svispl

General warranty information can be found at www.vernier.com/warranty

Disposal

When disposing of this electronic product, do not treat it as household waste. Its
disposal is subject to regulations that vary by country and region. This item should
be given to an applicable collection point for the recycling of electrical and
electronic equipment. By ensuring that this product is disposed of correctly, you
help prevent potential negative consequences on human health or on the
environment. The recycling of materials will help to conserve natural resources.
For more detailed information about recycling this product, contact your local city
office or your disposal service.

Battery recycling information is available at www.call2recycle.org

Do not puncture or expose the battery to excessive heat or flame.

== The symbol, shown here, indicates that this product must not be disposed of in
a standard waste container.
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Federal Communication Commission Interference Statement

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC rules. These
limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates,
uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on,
the user is encouraged to try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult the dealer or an experienced radio/TV technician for help.
FCC Caution
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference and
(2) this device must accept any interference received, including interference that may cause undesired operation
RF Exposure Warning

The equipment complies with RF exposure limits set forth for an uncontrolled environment. The antenna(s) used for this transmitter must not
be co-located or operating in conjunction with any other antenna or transmitter. You are cautioned that changes or modifications not
expressly approved by the party responsible for compliance could void your authority to operate the equipment.

IC Statement

This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to the following two conditions:
(1) this device may not cause interference, and
(2) this device must accept any interference, including interference that may cause undesired operation of the device.

Industry Canada - Class B This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus as set
out in the interference-causing equipment standard entitled “Digital Apparatus,” ICES-003 of Industry Canada. Operation is subject to the
following two conditions: (1) this device may not cause interference, and

(2) this device must accept any interference, including interference that may cause undesired operation of the device.

To reduce potential radio interference to other users, the antenna type and its gain should be so chosen that the equivalent isotropically
radiated power (e.i.r.p.) is not more than that permitted for successful communication.

RF exposure warning: The equipment complies with RF exposure limits set forth for an uncontrolled environment. The antenna(s) used for
this transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

Le présent appareil est conforme aux CNR d’Industrie Canada applicables aux appareils radio exempts de licence. L’exploitation est
autorisée aux deux conditions suivantes :

(1) l'appareil ne doit pas produire de brouillage, et

(2) l'appareil doit accepter tout interférence radioélectrique, méme si cela résulte a un brouillage susceptible d’en compromettre le
fonctionnement.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils numériques de Classe B prescrites dans la
norme sur le matériel interférant-brouilleur: “Appareils Numériques,” NMB-003 édictée par industrie Canada. L'utilisation est soumise aux
deux conditions suivantes:

(1) cet appareil ne peut causer d'interférences, et
(2) cet appareil doit accepter toutes interférences, y comprises celles susceptibles de provoquer un disfonctionnement du dispositif.

Afin de réduire les interférences radio potentielles pour les autres utilisateurs, le type d’antenne et son gain doivent étre choisie de telle
fagon que I'équivalent de puissance isotrope émis (e.i.r.p) n’est pas plus grand que celui permis pour une communication établie.

Avertissement d’exposition RF: L'équipement est conforme aux limites d’exposition aux RF établies pour un environnement non
supervisé. L’antenne (s) utilisée pour ce transmetteur ne doit pas étre jumelés ou fonctionner en conjonction avec toute autre antenne ou
transmetteur.

Note: This product is a sensitive measurement device. For best results, use the cables that were provided. Keep the device away from
electromagnetic noise sources, such as microwaves, monitors, electric motors, and appliances.
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Go Direct, Vernier Graphical Analysis, LabQuest, and other marks shown are our trademarks or registered trademarks
in the United States. All other marks not owned by us that appear herein are the property of their respective owners,
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